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Overview 

Touch Points capture interactions that businesses and individuals have with your company and brand. 

These can be both digital Touch Points (via your website, e-mail or social media channels) and non-

digital Touch Points (e.g account management calls and meetings).  

There are 4 different types of Touch Point: 

 Web (data captured through integration with web tracking tools – Gold-Vision integrates with 

either OnMonitoring or Lead Forensics) 

 E-mail (data captured through Gold-Vision Connect) 

 Social (data captured through integration with Twitter and Facebook) 

 Manual (data captured through Gold-Vision outcomes, such as a telephone call or note) 

Gold-Vision can be configured to score these Touch Points in accordance to their importance to your 

business, identifying hot prospects automatically. These scores are imported when the Touch Points 

are configured so a Lead scoring plan must be in place before this.  

The Touch Point area in Gold-Vision allows you to view, filter and report on these Touch Points in 

order to gain valuable business insight.  

You can view Touch Points by going to View > Touch Points > All Touch Points 

 

Touch Point Overview Screen 

This screen will be blank if you have not yet configured your Touch Points within the Administration 

Console. 
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Using Touch Points 

 Viewing Touch Points 
 
The Touch Point screen can be filtered by Touch Point source. Click on the icon for  types you wish to 
filter by and click ‘Go’. 

 
 
You can also filter Touch Points by ‘Accounts’, ‘Leads’ and ‘Unknown’ and also by time – ‘Today’, ‘7 
days’ and ’30 days’.  
When a Touch Point is imported Gold-Vision will see if the data matches any Account, Lead or 
Contact records. If it does Gold-Vision will automatically assign that Touch Point to the relevant 
record. The Account/ Lead name will be showing in blue, along with the Contact name if that has also 
been identified.  

 

If Gold-Vision can’t match the Touch Point against a Lead, Contact or Account record then the Touch 
Point will be red. By clicking on an unlinked Touch Point name you have the options to manually link it 
to a record or create a new record.  
 

 

 
 
Clicking the arrow shows the details of the site visit. 
 

 

 
 
You can filter Touch Points further by clicking on the ‘show sort and filter controls’ 
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You can filter by: 

- Touch Point Source – e.g Connect, Facebook 
- Action – e.g ‘Re-tweeted’, ‘Opened a Mail’  
- Company Name 
- Contact Name 
- Summary 
- Details 
- Category – these are predefined in the Administration Console 

- Score 
- Source – referring website 
- Industry  
- Account Type – E.g Re-seller, Prospect, Account.  
- Item Type 
- Created Date 

 

 Touch Point Actions 
Touch Point Actions differ depending on the Touch Point Source. The action is shown on the Touch 
Point record. 

 
Gold-Vision Connect 

- Opened a Mail 
- Clicked a Link 
- Forwarded a Mail  
- Replied to a Mail 

Gold-Vision Touch Points 

- Touch Points can be manually added when adding a note in Gold-Vision or  Lead 
Management 

Lead Forensics/ On-Monitoring  

- Website Visit 
- Single Page/ Bounce 

Facebook  

- Posted on Your Wall 
- Liked Your Post 
- Commented on Your Post 

Twitter 

- Replied to our Tweet 
- Followed Us 
- Re-Tweeted our Tweet 
- Mentioned us in a Tweet 
- Search all Tweet 
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 Reporting  

Standard reports are available from the Touch Points screen.  

 

 Categories 
You can define your own Touch Point categories and these can be configured within the 
Administration Console (see Touch Point Set-Up).  

 
You can associate a colour to each category and this colour will be displayed on the right hand side of 
the screen.  
 

 Scoring 
The score for the associated Touch Point will also be displayed on the right hand side of the screen. 
This is not the total score for the Account/Contact/Lead but just the score that has been assigned to 
the record because of this particular Touch Point. We will explain setting up Touch Point scores later 
on.  
Touch Point Scores in Account, Contact and Lead Records 
Accounts, Contacts and Leads will all build up a Touch Point score within their records. This will be an 
accumulation of all of the Touch Points related to a particular record.  
Account Touch Points 
You can view the Account Touch Point score, Last Touch Point date and Highest Score ever from the 
Account record. This will only be displayed if the Account has registered Touch Points. 
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You can view all of the Touch Points associated with an account by clicking on the Touch Point Score 
and also by going to: 

Overview > Events & Notes > Touch Points 

 
 
 
 
 

Touch  Points - This screen will show you all associated Touch Points: 

  
 

Reports- This screen shows you Touch Point score by category (pre-defined) and type: 

 
 

History - This graph shows the Touch Point score history: 
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The chart goes from blue, which the record was a lead, to red when they became a prospect.   

Contact Touch Points 
From the contact record click on ‘Business’ and then ‘Touch Points’: 

 
From here you will see the Touch Points associated with the contact record.  

The same options are available – Touch Points, Reports and History.  

 

Lead Touch Points 
Touch Point scores will show within the Lead record. If the Touch Point score is 0 then the blue bar 
will not be visible.  

 
 
The associated Touch Points will be available at the bottom of the Lead record: 
 

 
 

Manual/Gold-Vision Touch Points 
Touch Points can be added when adding a Note in Gold-Vision or Lead Management 
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Setting Up Touch Points 

 

 Touch Point Set-Up Overview 

 

Link Web Tracking 
Account (Optional)

Configure Touch 
Points

Setup Touch Point 
Alerting (Optional)

Configure 
Categories 
(Optional)

Test Touch Point 
Data

Define Touchpoint 
requirements 

(including scoring 
plan)

Authenticate Social 
Accounts (Optional)

View Touch Point 
Data in Gold-Vision

Setup 
Touchpoints

Enabling 
Touchpoints

Click to create 
New Account,
 New Contact, 

New Lead

View Account, 
Contact, Lead

Viewing 
Touchpoint 

Data

Reporting on 
Touchpoint 

Data

 

 

Touch Points must be configured within the Administration Console in order for data to be imported 

from the different sources. Please note the Data Transfer Service needs to be running for the 

Touch Points to be imported. 
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 Configuring Categories 
 
You can configure Touch Point categories to identify different types of Touch Points in the list view 
and in the Account/Contact Touch Pint reporting view. These are optional so you can skip this step if 
you do not require them.  
Your Touch Point categories could relate to the type of Touch Point you are tracking, for example: 

- Web 
- Social 
- E-mail 
- Non-digital 

You can assign a colour to each Touch Point category so that they are easy to identify in the User 
Interface.  
 
 
To configure your categories go to: 

Tools > Administration > Data > Touch Points > Touch Point Categories 

 
Once you are at this screen click ‘New’ to create a new Touch Point category. Name the category and 
choose an associated colour.  
 

  
You will then see the category appear under the Touch Point categories screen: 
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 Social Authentication 
In order to track social Touch Points you must first authenticate your social accounts. You will need 
to be the Administrator for your Company twitter Account or Facebook Page. You also need to 
authenticate any social accounts that you wish to send social campaigns from. There are two ways to 
do this – within the Administration Console and on the Preferences Tab. 

Administration Console 
Tools > Administration > Data > Touch Points > Social Authentication 

Here you can see authenticated social accounts for all users.   

 

To authenticate a social account click on the 
‘New’ icon. This will bring up the option to 
authenticate either a Twitter account or a 
Facebook account. Choose the option you 
require. For example authenticating the Gold-
Vision Twitter account.  

  

Before you click on the ‘Click here to authenticate 
with’ link, log in to your social media account via 
your browser. Once you click on the link you will 
be routed to an authentication page where you 
need to click ‘Authorize app’.  

 

 
You will then be directed to a screen to confirm 
whether the authentication has been successful.  

 

Preferences Tab 

 
To do this click on your name at the bottom left hand side of the screen: 
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Then click on ‘Home Page’ > ‘Social 
Authentication’ 

 

 
Then click ‘New’ 

 
This will bring up the option to authenticate either 
a Twitter account or a Facebook account. 
Choose the option you require and follow the 
same steps as above.   
The authenticated account will then be available 
to view in the Preferences tab 

 

You can authenticate as many social accounts as required and you are able to delete these by 
clicking on the cross on the right-hand side.  
If you want to track the interactions that happen on your Facebook business page you must 
authenticate the account associated with the page. Only information from the Facebook business 
pages will be tracked through Gold-Vision Touch Points.  
N.B – Accounts are authenticated on a per user basis – User A would not be able to broadcast social 
messages using an account User B has authenticated. Each user has to authenticate the social 
account in order to broadcast messages.  
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 Linking your Web Tracking Account 
To track your website visits you must first create an account with either Lead Forensics or 
OnMonitoring. Please contact your Account Manager for advice on this. Once you have an account 
set up it can be linked with Gold-Vision.  
Please ensure that before you configure any Touch Points that you are receiving data into your Lead 
Forensics or OnMonitoring portal. 
 
 

Configuring Touch Points 

 Introduction 
 
In order to begin importing Touch Points from the different sources into Gold-Vision you must firstly 
configure them within the Administration Console.  
N.B Before you configure your Touch Points you should have the following in place: 

o A Touch Point scoring plan – see separate document 
o If you plan to track website visits you need a linked OnMonitoring or Lead Forensics account  
o If you plan to track your social activity you need to authenticate your Company Twitter and/or 

Facebook accounts 
o If you plan to track your e-mail marketing you need a Gold-Vision Connect account and need 

to be using New mode Campaigns 
o If you wish to use Touch Point categories these must be configured 

 
Tools > Administration > Data > Touch Points > Configure Touch Point Rules 

 
 
The Touch Point configuration page is sorted by Touch Point Import Source: 
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 Touch  Point Configuration Examples 
This example shows you how to configure your Touch Points. The Touch Point Import Type in this 
example is Web Tracking. Other Touch Point Import Types are configured slightly differently and 
these are explained later.  Please see Tips below  
Here is an example Touch Point scoring plan: 

1. If a company goes on my pricing page give them a score of 20 and automatically create a 
Lead if they are unknown 

2. If a company goes on my demo page give them a score of 20 and automatically create a 
Lead if they are unknown  

3. If a company goes on my product page give them a score of 10 
4. If a company goes on any other page I want to track the visit but not assign a score 

Each of the four points above requires a separate Touch Point rule configured underneath the Web 
Tracking Import Source (either Lead Forensics or OnMonitoring depending on which account the 
customer has set up). In this example we will use Lead Forensics.   
To set up a Touch Point rule you need to click on the new icon next to the Import Source: 

 
This will bring up the following screen: 

 
You then need to fill out this form for the Touch Point rule. For example : 
Name – Pricing Page 
Category – Web Touch Point 
Action – You can choose more than one action here – ‘Web Site Visit’ will capture website visits of 
one or more pages. ‘Single Page / Bounce’ will capture website visits of only one page. It is likely that 
you choose either ‘web visit’ or both action types. Single page/bounces only track 1 page website 
visits so you may want to exclude these.  
Filters – Here you type in the URL of the page(s) that you would like to track. You can add multiple 
URLs or use the * button for wildcards. For example, *pricing, would track all visits to any URL with 
‘pricing’ in it. You also need to fill out the duration of the page visit. For example, if you only wanted to 
track visits to a page of more than 15 seconds you would enter ‘>0.25’. This can be left blank if you 
want to track all visits to the page, irrelevant of how long they spend on the page. In the above 
example no page times were specified so this will stay blank.  
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Scoring – Here you enter the score for the Touch Point rule. In the example above the score is 20. 
Touch Point scores can be degraded, so that they gradually move down to zero. You can choose how 
to degrade the score. For example, you might want an initial score of 50 but you want this score to 
degrade by 10 every 7 days. You can also choose to set the score to zero after a certain period of 
time. For example, you might want an initial score of 100 but you want this to revert back to zero after 
30 days.   
There may be instances where you want to assign a negative score – this is possible by inputting a 
negative figure. 
Linking – When a Touch Point is imported Gold-Vision will try to match the data against Contacts, 
Accounts and Leads. Here you can choose which fields to match against. It is recommended that you 
keep all of these ticked.  

 
Lead Import – You can automatically create Leads from Touch Points. To do this you must tick the 
Lead Import box. If the Touch Point is not matched to a Gold-Vision record then it will automatically 
create a Lead in a list of your choice. In this example we want to create a Lead so this box is ticked.  
Once you have filled out the form click ‘save’ and you will be routed back to the Touch Point 
configuration page. Here you will see the new rule sitting under the Import Source (Lead Forensics in 
this example).  

 

 
Repeat the process of setting up your Touch Point rules until all of them are showing under the Import 
Source.  



                                                                    TUTORIAL:              Touch Points – Gold-Vision 7 
 

Page 16 of 29 
 

 
 
The fourth rule needs to be configured slightly differently: 

“If a company goes on any other page I want to track the visit but not assign a score” 
The Touch Point rules not only define the Touch Point score – they also enable the import – so you 
do need to set up a generic rule if you want to capture all website visits. Do not specify a URL and 
keep the Touch Point score at zero. 
 

 

 Touch Point Rule Hierarchy 
As above, it is likely that you will set-up multiple rules for each Touch Point Source. It is important to 
understand that Touch Point imports are performed in the order they are visible on this page. In order 
to change the order of which they are run you can drag and drop the rows that appear under the 
Touch Point Sources.  
Each Touch Point will try and match a Touch Point rule, starting at the top of the funnel. Once the 
Touch Point has matched a rule it will be assigned the relevant score. We suggest that the import 
rules are ordered in most specific filters first to most generic last.    
Touch Point Import Types work slightly differently: 

- Connect & Social – Each action starts at the top of the funnel (e.g re-tweeted, clicked a link) 
- Web Tracking – Each page visited starts at the top of the funnel 
- Gold-Vision – These don’t work in the funnel way as they are 1 to 1 relationships. You can 

drag and drop the rules to change the order they appear in on the screen.  
 

 Touch Point Rule Funnel 
This image illustrates how the Touch Points are imported. Each action/page visit starts at the top of 
the funnel and Gold-Vision sees whether it matches the conditions of the first rule. It will carry on 
down the funnel until it matches a rule. It is then assigned the score that is associated with that rule.  
 

 
The only Touch Point Import Type that this doesn’t work with is Gold-Vision Touch Points. They work 
on a 1 to 1 basis. You can re-order these in the Administration Console and this is reflected in how 
they are displayed in the user interface 
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 Group Score Rules 
 
The group score rule is available for Connect Touch Points and Web Tracking Touch Points.  
 

 
 
These define how the ‘session’ score is calculated. For Connect this relates to the sequence of 
interactions a contact has with an e-mail (Opened, Clicked a Link etc). For web tracking this relates to 
a website visit. The group score rule sums the rules in different ways.  
The options available are: 

- Max Score (default)  
- Min Score  
- Sum Scores (all)  
- Sum Scores (by rule) 
- Average Score 

 
Using the Web Tracking example (see rules configured below), the session score will be different 
depending on which of the group score rules you chose.  
For example, if a company visited the website and went to the following pages a score would be 
associated to each page: 

- Home Page - 0 
- Demo - 20 
- Product Page 1 - 10 
- Contact Us - 0 
- Pricing - 20 
- Product Page 2 - 10 

The session score would be calculated as follows: 

- Max Score (default) - 20 
- Min Score - 0 
- Sum Scores (all) - 60 
- Sum Scores (by rule) - 50 
- Average Score – 10 

 
Connect Example: 

- Opened – 10 
- Clicked a Link – 20 
- Forwarded – 20 
- Replied – 30 

If a contact did all 4 of the actions above in one session (clicking on 2 links) then the score would be 
calculated differently depending on which of the options are selected below.  

- Max Score (default) - 30 
- Min Score - 10 
- Sum Scores (all) - 100 
- Sum Scores (by rule) - 80 
- Average Score – 25 
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 Tips 
 

 Check that you are receiving data from Lead Forensics/On Monitoring – this can be done by 
logging on to your portal 

 Check that the data is being sent to Gold-Vision. This is indicated by the Gold-Vision Logo in 
your Portal. You might need to add the logo to your view: 

 
 Check that the Data Transfer Service is running 

 Firstly create a ‘Catch All’ rule, leaving the URL blank – this will help to ensure that everything 
is working 

 Use the ‘Test Rules’ and check in your Gold-Vision that the test has worked ok. To do this 

you need to click on ‘Test’. 

 
Here you will see this page where you can fill out dummy Touch Point data. You will then see the 
Touch Point in the User Interface.  
 

 
 

Please contact support@gold-vision.com if Touch Points are not appearing in your Gold-Vision. 
 

  

mailto:support@gold-vision.com
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 Gold-Vision Connect Configuration 
 
Please note you will need to use New Mode Campaigns in order to use Connect Touch Points. 
 
To create a new Touch Point rule click ‘New’ next to Gold-Vision Connect. 

 

.  

 
 
Example Connect Touch Point: 
“I want to give anyone who opens a prospect e-mail a score of 10, degrading by 1 every 24 hours” 
Details 

 Enter the name of the Touch Point rule – ‘Prospect E-mail Open’ 

 Enter the Touch Point category – ‘E-mail’ 

 Choose ‘Active’ to ensure that the rule is active 
 

 
 

 

Action Types 
Tick the box of the Action Type that you would like to track. For Connect you can choose between: 

o Clicked a link 
o Forwarded a mail 
o Replied to a mail  
o Opened a mail 

The example is ‘Opened a mail’ so this is ticked.  
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Filters 
Optional fields, but all filter conditions must be met in order for the Touch Point to be imported.  

 Choose mailshot type (this is configured in the Administration Console) - Prospect E-mail 

 If you would like to track a specific link within Connect then enter this in the URL box. The 
example is not tracking a specific link so this can remain blank 

Scoring 
You can enter a score for the Touch Point import rule. This score can be set to degrade over time. If 
you do not want to give the Touch Point rule a score then you can simply leave this at zero. This will 
mean that the data will be imported but no score will be assigned to it.  
The score for this example is 10, degrading by 1 every 24 hours 

 
Linking 
When a Touch Point is imported Gold-Vision will try to match this against the existing Account, 
Contact and Lead records. This area allows you to choose which fields will be used to link Touch 
Point data to these records. It is advisable to keep all of these boxes checked in order to get as many 
Touch Points linked to records as possible.  

 
Once you have filled out the data for the Touch Point rule click Save, you will then be directed back to 
the main Touch Point configuration screen and you will see the new rule sitting under the Touch Point 
Source.  
 

 
 

It is likely that you will want to set-up multiple rules for Connect. These will all be listed on the Touch 
Point configuration screen in the Administration Console. 
Group Score Rule – Each Connect session score will be calculated using the rule you choose. See 
Group Scoring for more information on this. 
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 Gold-Vision Touch Points 
Gold-Vision Touch Points can be set up to manually give a score, for example you might wish to 
assign a Touch Point after a positive conversation with a Lead or a Contact. Set up the Touch Point 
as below then when adding a note there is the option to add a Touch Point. They can also be set up 
to be used in Alerting (see below) 
 

 
Details 

 Enter the name of the Touch Point rule 

 Enter the Touch Point category (see Touch Point Categories) 

 Choose ‘Active’ to ensure that the rule is active 
 

Action Types 
Enter the Action Type that you would like to track. For Gold-Vision you can choose between: 

o Manual – the Touch Point is available when adding a note in Gold-Vision or Lead 
Management 

o Alerting – the Touch Point is available in Alerting 
 

Scoring 
You need to enter a score for the Touch Point import rule. This score can be set to degrade over time. 
If you do not want to give the Touch Point rule a score then you can simply leave this at zero. This will 
mean that the data will be imported but no score will be assigned to it.  
 

 Social Touch Points – Facebook 

 
Details 

 Enter the name of the Touch Point rule 

 Enter the Touch Point category (see Touch Point Categories) 

 Choose ‘Active’ to ensure that the rule is active 
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Action Type 
Enter the Action Type that you would like to track. For Facebook you can choose between: 

o Posted on your Wall 
o Liked your Post 
o Commented on your Post 

 
Social Accounts 
Choose which social accounts you would like to pull data in from. All authenticated Facebook 
accounts will be showing here. If you haven’t authenticated a Facebook account please go to Social 
Authentication. 

Name  
Scoring 
You need to enter a score for the Touch Point import rule. This score can be set to degrade over time. 
If you do not want to give the Touch Point rule a score then you can simply leave this at zero. This will 
mean that the data will be imported but no score will be assigned to it.  
Linking 
When a Touch Point is imported Gold-Vision will try to match this against the existing Contact and 
Lead records.  

 

 
 

 Social Touch Point – Twitter 

 
Details 

 Enter the name of the Touch Point rule 

 Enter the Touch Point category (see Touch Point Categories) 

 Choose ‘Active’ to ensure that the rule is active 
Action Type 
Enter the Action Type that you would like to track. For Twitter you can choose between 

o Replied to our Tweet 
o Followed Us 
o Re-Tweetedto our Tweet 
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o Mentioned us in a Tweet 
o Search all Tweets 

Social Accounts 
Choose which social accounts you would like to pull data in from. All authenticated Facebook 
accounts will be showing here. If you haven’t authenticated a Facebook account please go to Social 
Authentication. 
Filters 
If you choose ‘Search all Tweets’ you must enter a search term in the filter. This can be a hashtag or 
a twitter handle. Warning – if you enter a popular hashtag, such as #crm, you will import a 
considerable amount of data which is not advisable.  

 
Scoring  
You need to enter a score for the Touch Point import rule. This score can be set to degrade over time. 
If you do not want to give the Touch Point rule a score then you can simply leave this at zero. This will 
mean that the data will be imported but no score will be assigned to it. 
Linking 
When a Touch Point is imported Gold-Vision will try to match this against the existing Account, 
Contact and Lead records. This area allows you to choose which fields will be used to link Touch 
Point data to these records. It is advisable to keep all of these boxes checked in order to get as many 
Touch Points linked to records as possible.  
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 Touch Point Rule Configuration Plan 

Below is an example of how to set up Touch Point Rules 

 Gold-Vision Connect Touch Points 
Sum scores total 

Name Category Action  Mail Shot 
Type 

URL Score  Degrade 
Score 

Prospect- 
clicked a 
link  

E-mail Clicked a 
link 

Prospect E-
mail 

N/A 10 0 after 21 
days 

Prospect – 
clicked a 
pricing link 

E-mail Clicked a 
link 

Prospect E-
mail 

www.gold-
vision.com/pricing 

20 0 after 21 
days 

Prospect – 
Forwarded 
a mail 

E-mail Forwarded 
a mail 

Prospect E-
mail 

N/A 5 0 after 21 
days 

Prospect – 
replied to a 
mail 

E-mail Replied to a 
mail 

Prospect E-
mail 

N/A 5 0 after 21 
days 

Prospect – 
opened a 
mail 

E-mail Opened a 
mail 

Prospect E-
mail 

N/A 5 0 after 21 
days 

 

 Gold-Vision Touch Points 
Name Category Action Type(s) Score Degrade Score 

Positive Feedback Verbal Manual * 20 0 after 21 days 

Negative 
Feedback 

Verbal Manual -100 No 

 IE when creating a note you can also add a Touch Point 

 

 

 Social Touch Points 
Twitter Touch Points 

Name Category Action Type(s) Social Accounts Score Degrade Score 

Twitter Social Replied 
Followed 
Re-Tweeted 
Mentioned 

Gold-Vision CRM 
Twitter Account 

5 0 after 24 hours 

 

Facebook Touch Points 

Name Category Action Type(s) Social Accounts Score Degrade Score 

Gold-
Vision 
CRM 

Social Posted 
Liked 
Commented 

GV Facebook 5 0 after 21 days 

 

http://www.gold-vision.com/pricing
http://www.gold-vision.com/pricing
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 Web Tracking Touch Points 
Sum scores total 

Page(s) Category Score Degrade 
Score 

Create Lead Duration 

Product Pages  
*gold-vision-crm 

Web 5 0 after 21 
days 

Yes More than 10 
secs 

Demo page 
http://www.gold-
vision.com/demo 
http://www.gold-
vision.com/demo/gold-
vision-demo 

Web 10 0 after 21 
days 

Yes More than 2 
secs 

Thank you pages 
*thank-you 

Web 10 0 after 21 
days 

Yes No 

Trial 
http://www.gold-
vision.com/gold-vision-trial 

Web 10 0 after 21 
days 

Yes More than 2 
seconds 

Contact Us 
http://www.gold-
vision.com/contact-us 

Web 10 0 after 21 
days 

Yes More than 2 
seconds 

Brochure Download 
Need to create thank you 
page 

Web 10 0 after 21 
days 

Yes No  

Implementation 
*implementation 

Web 5 0 after 21 
days 

Yes More than 10 
seconds 

Our Customers 
*our-customers 

Web 5 0 after 21 
days 

Yes More than 10 
seconds 

Pricing 
http://www.gold-
vision.com/pricing 

Web 20 0 after 21 
days 

Yes More than 2 
seconds 

 

 

  

http://www.gold-vision.com/demo/gold-vision-demo
http://www.gold-vision.com/demo/gold-vision-demo
http://www.gold-vision.com/demo/gold-vision-demo
http://www.gold-vision.com/gold-vision-trial
http://www.gold-vision.com/gold-vision-trial
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 Touch Point Automation  

Please note this is only available with Marketing Automation. 
 

 Touch Point Alerts  

With the release of Gold-Vision 7.0 a new Alert 
type is available called Touch Point Alert. This 
is located in the following location:  
 
Select New  Touch Point Alert 
 

 

This new alerting type allows users to create an 
alert based on a Touch Point score. 

 

 

There are three different types of Touch Point 
Alerts that can be setup: 

 

 

1) Account Touch Point: allows you to create a Touch Point alert associated to an Account. 

 

2) Contact Touch pint: allows you to create a Touch Point alert associated to a Contact. 

 

3) Lead Touch Point: allows you to create a Touch Point alert associated to a lead within the 
Lead Management area of Gold-Vision 

The following example will illustrate how to create a Touch Point alert. The alert will create an Account 
Activity when a Touch Point score for an Account is greater than 100 and then assign this Activity to 
the Account Manager with the summary of ‘Lead follow-up’.  

 

Select ‘Account Touch Point’  
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In the Alert text field this can be named ‘Create Account Activity when TP > 100 
In the ‘Raises over’ field enter 100 (this will cause the alert to fire when the Touch Point score is 
greater than 100. 
The Touch Point configurations list allows you to select a certain Touch Point(s) that have previously 
been configured in order to fire the alert. If no values are selected the overall Touch Point score is 
used for the alert to fire (the account Touch Point score in this example). 
For the purposes of this example do not select any Touch Point configuration items. 
 
 

Add a New Action allows you to specify what 
you would like to happen when the above 
conditions are met. 
Click ‘Add Action’, select ‘Create a New Activity’ 

 

Click the ‘Configure and manage data settings’ option that will now be displayed. 

 
This will then allow you to set the default values for the Activity that is created. 
 
 

Check the summary field and enter the following 
value ‘Lead follow-up’ (this will default the name 
of the activity to Lead follow-up) 
Check the owner field and select ‘Account 
Manager’ from the drop down list (this will set the 
associated Account Manager as the owner of the 
created Activity) 
 

 

Once done click Save. Click activate at the bottom of the screen to enable the Alert. The Alert will 
now create an Account Activity assigned to the Account Manager with the summary ‘Lead follow-up’ 
when the Touch Point score for the Account is greater than 100 

. 
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 Creating Touch Points from Alerts  

A new Alert action has been added to allow Touch Points to be added to an Item.  
For example – you may want to give a Touch Point score of 100 if an Opportunity of over 
£10,000 is created. 

Setting up Touch Points from Alerts is a two step process: 
1. Create a Touch Point with a type of ‘Manual’ 
2. Create an Alert adding this Touch Point as an Action 

Create the Manual Touch Point  
Data  Touch Points  Configure Touch Point Rules 
Select Gold-Vision Touch Points - New Rule 

 
 
Enter the Name, select Action Type Alerting and enter a score, Save 

 
 

Create an Alert 
Alerting  Configure Alerting  New Alert On Save Alert Select Opportunity 

 

Enter a name for the Alert 
Add a Condition eg  
When a numeric range has been reached 
 
Add a figure eg 10,000 in the ‘Greater than’ field 
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Add an Action 

Select Add Touch Point 

 

Select the Touch Point 

Click Save and Activate  

 
 

Once an Opportunity of over £10,000 is added, the Alert will fire and the Touch Point will be added: 

 
 

 


